
MS-Power Point 2007 

 

Very Short Answer Type Questions 

Question 1:  

Write down the name of default view in a PowerPoint presentation. 
 
Answer:  

By default, a presentation screen is always shown in Normal view. 

Question 2:  
Differentiate between a presentation and a slide. 
Answer: 
A presentation is a set of slides that you present to people in a group while each page 

of a PowerPoint presentation is called a slide. 

Question 3:  
Name two ways where you can create a presentation. 
 
Answer:  

You can create a presentation under Normal view and Outline view. 

Question 4:  

Write use of layouts in PowerPoint. 
 
Answer:  
Layouts are used to define the layout of the slide, i.e. the placement of title, subtitle, 

components of slide etc. 

Question 5:  
In PowerPoint 2007 under the Insert tab, there is a button named Text Box. What is the 
utility of this button? 
 
Answer:  

Like a title placeholder, a Text Box is used to hold the text information. 

Question 6:  
Is it possible to change the background of a slide at some later point of time? 
 
Answer:  

Yes, we can change the background of a slide at any point of time. 
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Question 7:  
Can graphics be inserted into the slide? 
 
Answer:  

Yes, we can insert pictures, graphs, charts, SmartArt etc., into a slide. 

Question 8: 
Animation is a feature, which you can use in your presentation. What is the purpose of 
this feature? 
 
Answer: 
Animations are the visual effects applied to individual items on a slide such as graphics, 

titles or bullet points, rather than to the slide itself. 

Question 9: 

Kirti wants to add sound to slide transition. Which feature of Animations tab is useful for 
this purpose? 
 
Answer:  

On the Animations tab in the Transition to This Slide group, click the arrow next to 
‘Transition Sound’ to add sound to slide transition. 

Question 10:  

Explain an advantage of grouping objects in PowerPoint. 
 
Answer:  
The grouped objects can move, transform, resize and also can change the properties of 

all the objects in a group together. 

Question 11: 

What is the use of Enter and Esc key in a Slide Show? 
 
Answer:  

Press Enter to move to the next slide and Esc to close the Slide Show. 

Short Answer Type Questions 

Question 1:  

Name any four basic elements of a slide. 
 
Answer:  

The four basic elements of a slide are as follows: 

1. Titles 
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2. Subtitles 
3. Drawing objects 

4. ClipArt 

Question 2:  
How many views of a slide PowerPoint provided? 
 
Answer:  

There are six views of a PowerPoint presentation: 

1. Normal view 
2. Outline view 
3. Notes Page view 
4. Slide Show 
5. Slide Sorter view 
6. Master view 

Question 3:  
State three functions of the Slides Pane. 
 
Answer:  

Three functions of the Slides Pane are as follows: . 

1. New slides may be added to the presentation. 
2. Allows marking a slide as hidden for not showing it during a slide show. 

3. Deleting a slide from the presentation in case it is no longer needed. 

Question 4:  

Write three functions that can be performed in Slide Sorter view of a presentation. 
 
Answer:  

The three functions that can be performed in Slide Sorter view are as follows: 

1. We can see the entire presentation. 
2. We can move slide from one place to another using click-drag method. Also, we 

can rearrange the order of slides. 

3. We can insert, rename and delete slides. 

Question 5:  

How are Header and Footer useful? 
 
Answer:  
Header and Footer are very useful for displaying the similar useful information on each 

slide. One can change the Header and Footer details at any time in the presentation. 
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Question 6:  
Write the steps of inserting picture in a slide. 
 
Answer:  

Pictures and ClipArt can be inserted into a Microsoft Office PowerPoint 2007 
presentation from sources such as ClipArt Website providers, Web pages or files on a 
computer. These pictures can be used as backgrounds for slides in a presentation. 
Here, we will discuss inserting pictures from files only, as per syllabus restrictions. 

Do the following for inserting pictures from file in your presentation: 

1. Click where you want to insert the picture. 
 

2. On the Insert tab, in the Illustrations group, click Picture option. 
 

 
 

3. Locate the picture that you want to insert and then double-click it. 

Or 
 

To add multiple pictures, press and hold Ctrl key while you click the pictures that you 
want to insert and then click Insert button. 
To insert a picture into the notes pages of an Office PowerPoint 2007 presentation, 
switch to Notes view and then do the above same procedure. 
 
Question 7:  

A sales manager creates a presentation he add the same slide transition to all the slide. 
Write steps, which are followed by sales manager for slide transition? 
 
Answer:  

Creating a slides show: 
Using PowerPoint, a wide range of special effects, such as transition and animation can 
be added in a presentation to provide visual interest to the presentation and grab the  
audience’s attention. H Points can be revealed on slides in a staggered way (i.e. one 
bullet displayed at a time) to keep the audience focused only on the point which is being 
discussed at the given time. Also, the presentation can be automated, so it runs on its 

own. The slide show can be enhanced by applying the following effects: 

1. Adding Transitions to a Slide 
2. Add Sound to Slide Transitions 
3. Animating Text and Objects 
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4. Rehearse Timing 

Question 8:  
What can you do if you want each slide should be shown for a specific amount of time? 
 
Answer:  

Setting advance slide to one mouse click is the default and a simple setting. If you want 
each slide to be shown for a specific amount of time, click automatically after and enter 

the number of seconds. Click Apply to All slides. 

Question 9:  
Differentiate between Slide Transition and Custom Animation. 
 
Answer:  

Differences between slide transition and custom animation are as follows: 

Slide Transition Custom Animation 

Slide transitions are the looks that 
take you from one slide to the next. 

Custom Animations are the movements you 
put on text, pictures, objects on an individual 
slide. 

Slide transitions apply to slides 
themselves. 

Custom Animations are applied to objects on a 
slide. 

 

Long Answer Type Questions 

Question 1:  
What are the different ways in which you can start creating a new presentation? Write 
steps for each. 
 
Answer: 
Creating New Presentation: 

For creating a new presentation in MS-PowerPoint, there are two options available to 
make a selection of creating new presentation: 
 
1. Creating Blank Presentation 

For creating a blank presentation, do the following: 

1. Click on Office button and then click New from the menu that appears. 
2. A New Presentation dialog box will appear. 
3. Select Blank Presentation and click on Create button. 

A blank presentation with one slide will be created. Also, further slides can be added to 
the presentation and can change the layout of an existing slide as well. 
 
2. Creating Presentation using Themes 
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You can quickly and easily format an entire presentation to give it a professional and 
modern look by applying a theme. 
In MS-PowerPoint 2007, you can apply theme using these two methods which are as 
follows: 
 
Method 1 

1.  
1. Click on Office button and then, click New from the menu that appears. 
2. A New Presentation dialog box will appear. 
3. From the right hand side page, select Installed Themes under Templates. 
4. Select any one of the theme as per the users choice. 

5. Click Create button. 

 

Method 2 

1. Select Design tab under the MS-PowerPoint 2007 ribbon menu system. 
2. Select Themes group under this tab. 
3. Select any one theme as per the choice. 
4. Effects will be automatically applied on all the slides. 

Saving a Presentation 

Procedure for saving a presentation is same as saving a MS-Word document and MS-
Excel workbook. For saving your presentation, do the following: 

1. Click on the Microsoft Office button and then, click Save As option from the menu 
that appear. 
Or 
Press Ctrl+S from keyboard. 
 

2. Save As dialog box will appear, in the File name box, enter a new name to save 
the file. 
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3. Then, click Save button. 

Question 2:  
Explain the various views of a slide available in PowerPoint 2007. 
 
Answer:  

In Microsoft Office PowerPoint 2007, different views of a slide are used to edit, print and 
deliver a presentation. PowerPoint slide views can be found in two places as 

follows: 

1. On the View tab, in the Presentation Views group, where all views are available. 
2. On an easy-accessible bar, at the bottom of the PowerPoint window, where the 

main views (Normal, Slide Sorter and Slide Show) are available. Different types of 
views available in PowerPoint 2007 are explained below: 
 

1. Normal View: This is the main editing view, where you write and design 

your presentations, i.e. actual screen which is displayed. The view is also 
known as Slide view. A Normal view is the default view size for the screen. 
 

2. Slide Sorter View: It provides a view of slides in thumbnail form. This view 
makes it easy to sort and organize the sequence of the slides at the time of 
creating presentation and also, at the time of preparing presentation for 
printing. 
 

3. Notes Page View: In the Notes Page view, the notes pane is located just 

below the slide pane. Here, notes that apply to the current slide can be 
typed. Later, these notes can be printed and referred while giving actual 
presentation. Notes can also be printed to handout to the audience or 
included in a presentation that is delivered to the audience or posted on a 
Web page. 
 

4. Slide Show View: This is used to deliver a presentation to the audience. 
Slide Show view takes up the full computer screen, like an actual 
presentation. In this view, you can see your presentation, the way audience 
wants. This view enables you to see how graphics, timings, movies, 
animated effects and transition effects will look during the actual 
presentation. To exit Slide Show view, press Esc key from the keyboard. 
 

5. Master View: The Master views include Slide view, Handout view and Notes 

view. They are the main slides that store information about the presentation, 
including background color, fonts effects, placeholder sizes and positions. 
The key benefit to working in a Master view is that on the Slide Master, 
Notes Master, or Handout Master, you can make universal style changes to 

every slide, notes page, or handout associated with the presentation. 
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Question 3:  
Which tab and command let you insert animations in your slide? Write the steps for 
applying animations in your presentation. 
 
Answer: 
Animating Text and Objects: 

We can give sound effects or visual effects, including movement to the text or objects in 
a presentation. Animation can be used to focus on important points, to control the flow 
of information and to increase viewer interest in a presentation. Built-in animation  
effect can be added in Office PowerPoint 2007 presentation by do the following: 

1. Select the text or object that you want to animate. 
2. On the Animations tab, in the Animations group, select the animation effect that 

you want from the animate list. 

To apply a custom animation effect in Office PowerPoint 2007, do the following: 

1. Select the text or object that you want to animate. 
2. On the Animations tab, in the Animations group, click Custom Animation. 

In the Custom Animation task pane, click Add Effect and then do one or more of 

the following: 

1. To make the enter text or object with an effect, point to Entrance and then click 
any effect. 
 

2. To add an effect, such as a Spin effect, to text or an object that is already visible 
on the slide, point to Emphasis and then click an effect. 

 
3. To add an effect that makes text or an object leave the slide at some point, click to 

Exit and then click an effect. 
 

4. To add an effect that makes text or an object move in a specified pattern, click to 

Motion Paths and then click a path. 
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To specify how the effect is applied to your text or object, right-click any custom 
animation effect in the Custom Animation list and then click Effect Options. 
Do one of the following: 

1. To specify settings for text, on the Effect, Timing and tabs, click the options 
Animate text from Effect tab to use to animate the text. 
 

2. To specify settings for an object, on the Effect and Timing tabs, click the options 

that you want to use to animate the object. 

Effects appear in the Custom Animation list in the order that you add them. 

Question 4:  

Write the steps to print handouts in PowerPoint presentation. 
 
Answer:  
Printing Slide Handouts: 

We have already studied about the handouts view of presentation, it could help the 
audience in getting idea of yours easily. A presentation can be printed in the form of 
handouts-with one, two, three, four, six or nine slides on a page. 
For printing handouts, you need to do the following: 

1. Open the presentation for which you want to print handouts. 
 

2. Click the Microsoft Office button, click the arrow next to Print option and then click 
Print Preview. 
 

3. In the Page Setup group, click the arrow under Print What: and then select the 
handout layout option that you want from the list. 
 

4. To specify the page orientation, click the arrow under Orientation and .then click 
Landscape or Portrait. 
 

5. Click Print. 

Application Oriented Questions 

Question 1:  

Complete the blank spaces using words from the list. You should use each word only 
once. Websites, slide, PowerPoint, presentation, templates, handouts, projector. 
MS (1)………………… is a (2)………………… program that lets you make and show 
slide shows. These can be viewed on the computer screen or through a multimedia 
(3)………………… Copies of the presentation, called (4)………………… that can be 
printed out and given to the audience so that, they can make their own notes. 
Presentations are made up of a series of pages, called (5)………………… as well as 
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text, slides may incorporate graphics, animated images , sounds and video clips, 
graphs, charts and even links to (6)………………… Most presentation packages provide 
a set of themes and (7)………………… which make it easy to create professional 
looking presentations with little skill or knowledge. They also offer the facility to add 
slide transition, timing and animations, which bring a presentation’s to life. 
 

Answer: 

1. PowerPoint 
2. presentation 
3. projector 
4. handouts 
5. slide 
6. Websites 

7. templates 

Question 2:  
Seema wants to give identical design to all the slides and handouts, she is going to print 

from her presentation. 

1. Which two methods can she use to accomplish her task? 

2. Compare the two methods and in list their differences. 

Answer: 

1. Seema can do this in following two ways: 
1. Creating same design on each slide and handouts manually. 
2. Using slide master and handout master. 

 
2. In the first method, the efforts are increased by many efforts and many errors in 

design may creep in. 
The second method ensures reduce efforts and identical design on each slide and 

handout. 

Question 3:  

Ketan is preparing a presentation for his new product promotion. 

1. The content is ready but he has no time to design backgrounds and decide on 
color scheme for the presentation. Name the features that will help him to create a 
professional presentation without devoting much time. 
 

2. He wants to set how a slide appears and disappears on screen when he runs the 
slide show. Which feature should he use? 

Answer: 
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1. He has to take with the help of master pages from task pane to set a suitable 
background which supports descent color background. 

2. He must have to set some slide transition and custom animation effect from task 
pane. 

Question 4:  

Suman is working as marketing manager in an advertising company. She has prepared 
a presentation on her latest product. What feature will be used for the following tasks? 

1. To view all slides together. 
2. To set timings of the slide show while rehearsing. 
3. To show the sales using a chart. 

Answer: 

1. Press the Slide Sorter view button in work space area to view all the slides 
together. 

2. In the Slide Transition page, set the timing in Advance slide sections automatically 
after position where the slide will automatically play after a speculated time period. 

3. In the layouts of tasks pane, select a chart type slide or use Insert —> Chart menu 
option. 

Question 5:  
Malini has recently joined a construction company as marketing executive. She saw a 
presentation about the company. She however is not satisfied with it and wants to make 
some changes in it. Using your presentation skills, suggest the features to accomplish 

the following changes: 

1. Add the company’s logo on the first slide. 
2. Add audio to explain the content of the slide. 
3. Connect slide 2 to slide 7 directly. 
4. Add date and time on all slides. 

Answer: 

1. Insert Picture 
2. Record Narration 
3. Hyperlink/Interaction feature 
4. Header and Footer dialog box 

Multiple Choice Questions 

Question 1:  

………………. is the default file name for a PowerPoint presentation. 
(a) Untitled 1            (b) Book 
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(c) Presentation 1    (d) Document 1 
 
Answer:  
(c) The default name given to a presentation file is Presentationl. 

Question 2:  

File extension for a PowerPoint 2007 presentation is ………………. 
(a) .ptt                (b) .pptx               (c) .docx            (d) .clsx 
 
Answer:  

(b) .pptx is the file extension given to all PowerPoint 2007 files. 

Question 3:  

The custom animation can apply ………………. 
(a) Font work gallery        (b) Gallery 
(c) Text                             (d) All of these 
 
Answer:  
(d) The custom animation can apply font work gallery, gallery and text. 

Question 4: 

Professional looking visual aids are prepared with the help of software called 
………………. 
(a) DBMS 
(b) Multimedia 
(c) Graphics software 
(d) Presentation graphics software 
 
Answer:  
(d) Professional looking visual aids are prepared with the help of software called 

Presentation graphics software. 

Question 5:  
A set of predefined formats of text or color scheme is called ………………. 
(a) slide              (b) presentation scheme 
(c) theme            (d) schema 
 
Answer:  

(c) A set of predefined formats of text or color scheme is called theme. 

Question 6: 
Which of the following view is useful for representing the structure of a presentation? 
(a) Notes view      (b) Outline view 
(c) Slide view       (d) Normal view 
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Answer: 
(b) Outline view is useful for checking the flow or structure of a presentation. 

Question 7:  

The entire presentation can be seen at a time in ………………. 
(a) Slide Show view      (b) Outline view 
(c) Normal view             (d) Slide Sorter view 
 
Answer: 
(d) Slide Sorter view enables you to view the entire presentation at a time. 

Question 8: 
Which among the following views allows you to give a thumbnail view of all the slides in 
a presentation? 
(a) Normal view            (b) Outline view 
(c) Notes view               (d) Slide Sorter view 
 
Answer:  
(d) Slide Sorter view 

Question 9:  

Which among the following views allows you to add some extra information to a slide 
which is not viewed during the presentation. 
(a) Normal view            (b) Outline view 
(c) Notes Page view     (d) Slide Sorter view 
 
Answer: 
(c) Notes Page view allows you to add some extra information related to presentation 

but it is not viewed during the presentation. 

Question 10:  
Which file format can be added to a PowerPoint show? 
(a) .jpg               (b) .gif 
(c) .wav              (d) All of these 
 
Answer:  
(d) .jpg and .gif are file extensions for images and .wav is an extension for video file. 

Hence, all these formats are supported in PowerPoint. 

Question 11:  

Rama is preparing a presentation on her company’s annual performance. She wants 
some text present on a slide to fly in from the left, when she clicks the mouse. Which of 
the following features should she use? 
(a) Slide Show  
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(b) Slide Transition 
(c) Custom Animation 
(d) Text Animation 
 
Answer:  
(c) Custom Animation can be used for the desired functionality. 

 
Question 12: 

Special effects used to introduce slides in a presentation are ………………. 
(a) transitions                    (b) effects 
(c) custom animations      (d) annotations 
 
Answer:  
(a) Special effects used to introduce slides in a presentation are known as transitions. 

Question 13: 

Rehearse Timings command is present on ………………. tab. 
(a) Animations                 (b) Review 
(c) Slide Show                 (d) View 
 
Answer:  
(c) Rehearse Timings command is present on Slide Show tab. 

Question 14:  
Set new timing, while rehearsing ……………… key is press. 
(a) Ctrl+T 
(b) T 
(c) M 
(d) O 
 
Answer:  

(b) T key is used to set new timing while rehearsing. 

Question 15:  
What is the shortcut key to display the Microsoft PowerPoint shortcut menu? 
(a) F7 
(b) F8 
(c) Shift+F10 
(d) Fit 
 
Answer: 

(c) Shift + F10 is the shortcut key to display the PowerPoint shortcut menu. 

Fill in the Blanks 

www.dr
ea

mtop
pe

r.in



Question 1:  
………………. is a presentation graphics software. 
 
Answer:  

PowerPoint 

Question 2:  
An electronic page in a presentation is called ……………….. 
 
Answer: 

slide 

Question 3:  

A ………………. is a pre-designed format of text and color scheme. 
 
Answer:  

template 

Question 4:  

………………. provides a command to change the layout of your slide. 
 
Answer:  

Home tab 

Question 5:  
New Slide button for inserting a new slide can be found on ………………. tab. 
 
Answer:  

Home 

Question 6:  
A ………………. is a box with a dotted outline, designed for the placement of different 
type of content on the slide. 
 
Answer:  

Placeholder 

Question 7:  
From ………………. page, it is possible for you to choose slide designs. 
 
Answer:  

Layout 
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Question 8:  
In ………………. view, you can see all the slides in a presentation concurrently. 
 
Answer:  

Slide Sorter 

Question 9:  
To select slides at discrete order in the Slides Pane you need hold the ………………. on 
the keyboard while selecting the slides. 
 
Answer:  

Ctrl key 

Question 10:  
………………. is a special effect that allows to specify how to navigate from one slide to 
other. 
 
Answer:  

Transition 

Question 11:  

The ………………. Animation enhance uses the flying effect on the text and character. 
 
Answer:  

Custom 

Question 12: 
The Custom Animation command is present on ………………. tab. 
 
Answer: 

Animations 

True or False 

Question 1:  
Every presentation can contain only one single slide. 
 
Answer: 
False A presentation is a collection of multiple slides. 
 
Question 2:  
Changing a slide layout is not allowed in PowerPoint. 
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Answer: 
False Under Home tab by clicking at Layout button, you can change layout of a slide. 

Question 3:  

Microsoft Office button contains options for frequently used tasks, such as opening, 
saving and printing. 
 
Answer:  
True Open, Save, Save As, Print are frequently used tasks that are available on 

Microsoft Office button menu. 

Question 4:  
We cannot insert audio recording sound in a slide. 
 
Answer:  

False We can insert audio recording sound in a slide. 

Question 5:  
Objects on the slide that hold text are called placeholder. 
 
Answer:  

True Placeholders hold the text, ClipArt, charts etc. 

Question 6:  

We can delete slides in Slide Sorter view. 
 
Answer:  
False Use this view to work with a group of slides or with only one slide. 

Question 7: 

Special effects used to introduce slides in a presentation are called transitions. 
 
Answer:  
True Special effects used to introduce slides in a presentation are called transitions. 

Question 8:  
To change the slides during the Slide Show is called Animation. 
Answer:  
True Animation can be used to changes in slides during the Slide Show. 

Question 9:  

F4 key is used to start a Slide Show. 
Answer:  

False F5 key is used to start a Slide Show. 
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